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What are styles?

What are styles?

A style is a set of formats that you can apply to selected pages, text, frames, and other 
elements in your document to quickly change their appearance. When you apply a style, you 
apply a whole group of formats at the same time.

OpenOffice.org supports the following types of styles:

• Page styles include margins, headers and footers, borders and backgrounds. In Calc, page 
styles also include the sequence for printing sheets.

• Paragraph styles control all aspects of a paragraph’s appearance, such as text alignment, tab 
stops, line spacing, and borders, and can include character formatting. 

• Character styles affect selected text within a paragraph, such as the font and size of text, or 
bold and italic formats.

• Frame styles are used to format graphic and text frames, including wrapping type, borders, 
backgrounds, and columns.

• Numbering styles apply similar alignment, numbering or bullet characters, and fonts to 
numbered or bulleted lists.

• Cell styles include fonts, alignment, borders, background, number formats (for example, 
currency, date, number), and cell protection.

• Graphics styles in drawings and presentations include line, area, shadowing, transparency, 
font, connectors, dimensioning, and other attributes.

• Presentation styles include attributes for font, indents, spacing, alignment, and tabs.

Different styles are available in the various components of OOo, as listed in Table 1.

Table 1. Styles available in OOo components

Style Type Writer Calc Draw Impress

Page X X

Paragraph X

Character X

Frame X

Numbering X

Cell X

Presentation X X

Graphics (included in 
Frame styles)

X X

OpenOffice.org comes with many predefined styles. You can use the styles as provided, modify 
them, or create new styles, as described in this chapter.
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Why use styles?

Why use styles?

Many people manually format paragraphs, words, tables, page layouts, and other parts of their 
documents without paying any attention to styles. They are used to writing documents according to 
physical attributes. For example, you might specify the font family, font size, and any formatting 
such as bold or italic.

Styles are logical attributes. Using styles means that you stop saying “font size 14pt, Times New 
Roman, bold, centered”, and you start saying “Title” because you have defined the “Title” style to 
have those characteristics. In other words, styles means that you shift the emphasis from what the 
text (or page, or other element) looks like, to what the text is.

Styles help improve consistency in a document. They also make major formatting changes easy. For 
example, you may decide to change the indentation of all paragraphs, or change the font of all titles. 
For a long document, this simple task can be prohibitive. Styles make the task easy.

In addition, styles are used by OpenOffice.org for many processes, even if you are not aware of 
them. For example, OOo relies on heading styles (or other styles you specify) when it compiles a 
table of contents.

Examples of page style use

The following examples of common use of page styles are taken from Writer. There are many other 
ways to use styles. See Chapter 6 (Introduction to Styles) and Chapter 7 (Working with Styles) in the 
Writer Guide for instructions on getting the most out of page, paragraph, character, list, and frame 
styles.

Defining a different first page for a document
Many documents, such as letters and reports, have a first page that is different from the other pages 
in the document. For example, the first page of a letterhead typically has a different header, or the 
first page of a report might have no header or footer, while the other pages do. With OOo, you can 
define the page style for the first page and specify the style for the following pages to be applied 
automatically.

As an example, we can use the First Page and Default page styles that come with OOo. Figure 1 
shows what we want to happen: the first page is to be followed by the default page, and all the 
following pages are to be in the Default page style. Details are in Chapter 4 (Formatting Pages) in the 
Writer Guide.

Figure 1: Flow of page styles
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Examples of page style use

Dividing a document into chapters
In a similar way, you can divide a document into chapters. Each chapter might start with the First  
Page style, with the following pages using the Default page style, as above. At the end of the chapter, 
we can insert a manual page break and specify the next page to have the First Page style to start the 
next chapter.

Figure 2: Dividing a document into chapters using page styles

Changing page orientation within a document
A document can contain pages in more than one orientation. A common scenario is to have a 
landscape page in the middle of a document, whereas the other pages are in a portrait 
orientation. This can also be done with page breaks and page styles.

Figure 3. Inserting a page with special formatting

Different headers on right and left pages
Page styles can be set up to have the facing left and right pages mirrored or only right (first pages of 
chapters are often defined to be right-page only) or only left. When you insert a header on a page 
style set up for mirrored pages or right-and-left pages, you can have the contents of the header be the 
same on all pages or be different on the right and left pages.

To allow different content in headers, clear the Same content left/right checkbox in the Header area 
on the Header page of the Page Style dialog (Figure 4).

Figure 4. Different header content
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Examples of page style use

Now, you can put the page number on the left-hand edge of the left pages and on the right-hand edge 
of the right pages, put the document title on the right-hand page only, or make other changes. Figure
5 shows an example.

Figure 5. Different content on left and right pages

Examples of paragraph style use

The following examples of common use of paragraph styles are taken from Writer.

Controlling page breaks automatically
Writer automatically flows text from one page to the next. If you do not like the default settings, you 
can change them on the Text Flow page of the Paragraph Style dialog.

The Options section (Figure 6) provides settings to control what happens when a paragraph does not 
fit on the bottom of a page.

Figure 6: Options for controlling automatic page or column breaks

You can require a paragraph to start on a new page or column and specify the style of the new page. 
A typical use is for chapter titles that you always want to start on a new page. In the Breaks section 
of the Text Flow page of the Paragraph Style dialog:

1) Select Insert. Make sure that Type is set to Page and Position to Before.

2) Select With Page Style and choose the page style from the list.

3) To continue page numbering from the previous chapter, leave Page number set at 0. To start 
each chapter’s page numbering at 1, set Page number to 1.

Figure 7: Setting a paragraph style to always start on a new page
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Examples of paragraph style use

Compiling an automatic table of contents
In order for Writer to compile an automatic table of contents, the headings that are to appear in the 
contents list must be identified as headinga. You do this by applying styles to them. Writer comes 
with 10 levels of predefined heading styles. You can change the formatting (font, color, size, and so 
on) of these predefined heading styles, and you can define your own custom styles. Then use Tools > 
Outline Numbering to tell Writer which styles go with which level in the table of contents.

Speeding up work by defining a sequence of styles
You can set up one paragraph style so that when you press enter at the end of that paragraph, the 
following paragraph automatically has the style you wish applied to it. For example, you could 
define a Heading 1 paragraph to be followed by a Text Body paragraph. A more complex example 
would be: Title followed by Author followed by Abstract followed by Heading 1 followed by Text  
Body. By setting up these sequences, you can avoid manually applying styles in most cases.

Applying styles

OpenOffice.org provides several ways for you to select styles to apply.

Using the Styles and Formatting window

1) Click the Styles and Formatting icon  located at the left-hand end of the object bar, or 
click Format > Styles and Formatting, or press F11. The Styles and Formatting window 
shows the types of styles available for the OOo component you are using. Figure 8 shows the 
window for Writer, with Page Styles visible.

You can move this window to a convenient position on the screen or dock it to an edge (hold 
down the Ctrl key and drag it by the title bar to where you want it docked).

2) Click on one of the icons at the top left of the Styles and Formatting window to display a list 
of styles in a particular category.

3) To apply an existing style (except for character styles), position the insertion point in the 
paragraph, frame, or page, and then double-click on the name of the style in one of these lists. 
To apply a character style, select the characters first.

Tip At the bottom of the Styles and Formatting window is a dropdown list. In Figure 8 
the window shows Automatic, meaning the list includes only styles applied 
automatically by OOo. You can choose to show all styles or other groups of styles, 
for example only custom styles.

Working with Styles 5



Applying styles

Figure 8. The Styles and Formatting window for Writer, showing paragraph styles

Using Fill Format mode
Use Fill Format to apply a style to many different areas quickly without having to go back to the 
Styles and Formatting window and double-click every time. This method is quite useful when you 
need to format many scattered paragraphs, cells, or other items with the same style.

1) Open the Styles and Formatting window (Figure 8) and select the style you want to apply.

2) Click the Fill Format mode icon . 

3) To apply a paragraph, page, or frame style, hover the mouse over the paragraph, page, or 
frame and click. To apply a character style, hold down the mouse button while selecting the 
characters, Clicking on a word applies the character style for that word. Repeat step 3 until 
you made all the changes for that style.

4) To quit Fill Format mode, click the Fill Format mode icon again or press the Esc key.

Caution When this mode is active, a right-click anywhere in the document undoes the 
last Fill Format action. Be careful not to accidentally right-click and thus undo 
actions you want to keep.

Using the Apply Style list
After you have used a style at least once in a document, the style name appears on the Apply Style 
list (Figure 9) at the left-hand end of the Formatting toolbar, next to the Styles and Formatting icon.

You can open this list and click once on the style you want, or you can use the up and down arrow 
keys to move through the list and then press Enter to apply the highlighted style.

Tip Select More... at the bottom of the list to open the Styles and Formatting window.
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Applying styles

Figure 9. The Apply Style list on the Formatting toolbar

Assigning styles to shortcut keys
OOo provides a set of predefined keyboard shortcuts that allow you to quickly apply styles while 
typing in a document. You can redefine these shortcuts or define your own.

1) Click Tools > Customize > Keyboard. The Keyboard page of the Customize dialog (Figure
10) opens.

2) To have the shortcut key assignment available only with one component (for example, 
Writer), select that component’s name in the upper right corner of the page; otherwise select 
OpenOffice.org button to make it available to every component.

3) Choose the shortcut keys you want to define. In this example we have chosen Ctrl+9.

4) In the Functions section at the bottom of the dialog, scroll down in the Category list to 
Styles and click the + sign.

5) Choose the type of style (our example uses a paragraph style). The Function list will display 
the names of the available styles for the selected type. The example shows some of OOo’s 
predefined styles.

6) To set Ctrl+9 to be the shortcut key combination for the Text Body style, select Text Body in 
the Function list, and then click Modify. Ctrl+9 now appears in the Keys list.

7) Make any other required changes and then click OK to save these settings and close the 
dialog.
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Applying styles

.

Figure 10. Defining keyboard shortcuts for applying styles

Modifying styles

OpenOffice.org provides several ways to modify styles (both the predefined styles and custom styles 
that you create):

• Changing a style using the Style dialog

• Updating a style from a selection

• Use AutoUpdate (paragraph and frame styles only)

• Load or copy styles from another document or template

Tip Any changes you make to a style are effective only in the current document. To 
change styles in more than one document, you need to change the template (see 
Chapter 12, Working with Templates) or copy the styles into the other documents as 
described in “Copying and moving styles“ on page 11.
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Modifying styles

Changing a style using the Style dialog
To change an existing style using the Style dialog, right-click on the required style in the Styles and 
Formatting window (Figure 8) and select Modify from the pop-up menu.

The Style dialog displayed depends on the type of style selected. Each style dialog has several tabs. 
See the chapters on styles in the user guides for details.

Updating a style from a selection
To update a style from a selection:

1) Open the Styles and Formatting window.

2) In the document, select an item that has the format you want to adopt as a style.

Caution Make sure that there are unique properties in this paragraph. For example, if 
there are two different font sizes or font styles, that particular property will 
remain the same as before.

3) In the Styles and Formatting window, select the style you want to update (single-click, not 
double-click), then long-click on the arrow next to the New Style from Selection icon and 
click on Update Style (see Figure 11).

Figure 11. Updating a style from a selection

Using AutoUpdate (paragraph and frame styles only)
If the AutoUpdate checkbox is selected on the Organizer page of the Paragraph Style or Frame Style 
dialog, applying direct formatting to a paragraph or frame using this style in your document 
automatically updates the style itself.

Tip If you are in the habit of manually overriding styles in your document, be sure that 
AutoUpdate is not enabled. 

Updating styles from another document or template
You can update styles by copying or loading them from a template or another document. See 
“Copying and moving styles” on page 11.
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Creating new (custom) styles

Creating new (custom) styles

You may want to add some new styles. You can do this in two ways:

• Creating a new style using the Style dialog
• Creating a new style from a selection

Creating a new style using the Style dialog
To create a new style using the Style dialog, right-click in the Styles and Formatting window and 
select New from the pop-up menu.

If you want your new style to be linked with an existing style, first select that style and then right-
click and select New.

If you link styles, then when you change the base style (for example, by changing the font from 
Times to Helvetica), all the linked fonts will change as well. Sometimes this is exactly what you 
want; other times you do not want the changes to apply to all the linked styles. It pays to plan ahead.

The dialogs and choices are the same for defining new styles and for modifying existing styles. See 
the chapters on styles in the user guides for details.

Creating a new style from a selection
You can create a new style by copying an existing style. This new style applies only to this 
document; it will not be saved in the template.

1) Open the Styles and Formatting window and choose the type of style you want to create.

2) In the document, select the item you want to save as a style.

3) In the Styles and Formatting window, click on the New Style from Selection icon.

4) In the Create Style dialog (Figure 12), type a name for the new style. The list shows the 
names of existing custom styles of the selected type. Click OK to save the new style.

Figure 12: Naming a new style created from a selection
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Creating new (custom) styles

Dragging and dropping a selection to create a style
You can drag and drop a text selection into the Styles and Formatting window to create a new style.

Writer
Select some text and drag it to the Styles and Formatting window. If Paragraph Styles are active, the 
paragraph style will be added to the list. If Character Styles are active, the character style will be 
added to the list.

Calc
Drag a cell selection to the Styles and Formatting window to create cell styles.

Draw/Impress
Select and drag drawing objects to the Styles and Formatting window to create graphics styles.

Copying and moving styles

You can copy or move styles from one template or document into another template or document, in 
two ways:

• Using the Template Management dialog

• Loading styles from a template or document

Using the Template Management dialog
To copy or move styles using the Template Management dialog:

1) Click File > Templates > Organize.

2) In the Template Management dialog (Figure 14), set the lists at the bottom to either Templates 
or Documents, as needed. The default is Templates on the left and Documents on the right.

Tip To load styles from a file that is not open, click the File button. When you return to 
this window, both lists show the selected file as well as all the currently open 
documents.

3) Open the folders and find the templates from and to which you want to copy. Double-click on 
the name of the template or document, and then double-click the Styles icon to show the list 
of individual styles (Figure 14).

4) To copy a style, hold down the Ctrl key and drag the name of the style from one list to the 
other.

Caution If you do not hold down the Control key when dragging, the style will be moved 
from one list to the other. The style will be deleted from the list you are dragging it 
from.

5) Repeat for each style you want to copy. If the receiving template or document has a lot of 
styles, you may not see any change on screen unless you scroll down in the list. When you are 
finished, click Close.
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Copying and moving styles

Figure 13: Choosing to copy styles from a document, not a template

Figure 14: Copying a style from one document to another

Loading styles from a template or document
You can copy styles by loading them from a template or another document:

1) Open the document you want to copy styles into.

2) In the Styles and Formatting window, long-click on the arrow next to the New Style from 
Selection icon, and then click on Load Styles (see Figure 11).

3) On the Load Styles dialog (Figure 15), find and select the template you want to copy styles 
from.
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Copying and moving styles

Figure 15. Copying styles from a template into the open document

4) Select the checkboxes for the categories of styles to be copied. Select Overwrite if you want 
the styles being copied to replace any styles of the same names in the document you’re 
copying them into.

5) Click OK to copy the styles. You will not see any change on screen.

Note To copy the styles from another document, click the From File button to open a 
window from which you can select the required document.

Deleting styles

You cannot remove (delete) any of OOo’s predefined styles from a document or template, even if 
they are not in use.

You can remove any user-defined (custom) styles; but before you do, you should make sure the 
styles are not in use. If an unwanted style is in use, you will want to replace it with a substitute style.

To delete unwanted styles, right-click on them (one at a time) in the Styles and Formatting window 
and click Delete on the pop-up menu.

If the style is in use, you receive the message shown in Figure 16.

Figure 16. Deleting an applied style

Caution Make sure the style is not in use before deletion. Otherwise, all objects with that 
style will return to the default style and retain their formatting as manual 
formatting. This can be a problem in a long document.

If the style is not in use, you receive a confirmation message; click Yes.
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